


CONTENTS
INSTALLING THE GAME .................................. 1
STARTING THE GAME ..................................... 1
COMPLETE CONTROLS ....................................2
INTRODUCTION ................................................3
SETTING UP THE GAME ...................................3

MAIN MENU .................................................................3

OPTIONS .....................................................................3

PLAYING THE GAME ....................................... 4
GAME SCREEN ............................................................. 4

CUSTOMIZE YOUR RIDE ................................................ 4

GAME MODES ..................................................6
CAREER MODE ............................................................. 6

QUICK RACE MODE ........................................................7

ONLINE .......................................................................7

LAN ........................................................................... 9

SAVING AND LOADING ....................................9
PERFORMANCE TIPS .....................................10

SYSTEM REQUIREMENTS ............................................. 10

BACKGROUND TASKS .................................................. 10

VIDEO AND SOUND DRIVERS ........................................ 10

INTERNET PERFORMANCE ISSUES ..................................11

TECHNICAL SUPPORT ................................... 11
WARRANTY .................................................. IBC

For more info about this and other titles, check out EA GAMES™ on the web at 
www.eagames.com.



1

INSTALLING THE GAME
To install Need For Speed™ Underground 2:
1. Close all open programs and background tasks, including virus scanners (see 

Performance Tips on p. 10 for more info).
2. Insert the Need For Speed Underground 2 Disc 1 into your CD/DVD-ROM drive. The 

Autorun menu appears.

NOTE: If the Autorun menu does not automatically appear, left-click the Start 
button from the Windows® Taskbar and select Run…. Type D:\autorun.exe in the 
Run dialog box, then click OK (substitute the correct letter of your CD/DVD-ROM 
drive if other than ‘D:’).

3. Click the INSTALL button on the Autorun menu, then follow the on-screen instructions to 
complete the installation.

STARTING THE GAME
To start Need For Speed Underground 2 (with disc already 
in drive):
1. Close all open programs and background tasks, including virus scanners (see 

Performance Tips on p. 10 for more info).
2. Left-click the Start button from the Windows Taskbar and select All Programs 

(or Programs) > EA GAMES > Need for Speed Underground 2 > Need for Speed 
Underground 2.
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COMPLETE CONTROLS
GENERAL GAMEPLAY
ACTION PRIMARY SECONDARY

Steer Left/Right j/l A/D
Throttle i W

Reverse k S

Shift Up q (left) ;

Shift Down v (left) .

E-Brake   u

Nitrous a (left) a (right)

Camera C f

Look Back B y

Enter Race/Shop e ¡

World Map M ™

Read SMS (Career mode only) t £

Career Statistics (Career mode only) T ¢

Reset Car R h

Hydraulics Pressure H Y

Hydraulics Bounce J U

Pause s P

MENU CONTROLS
ACTION KEYBOARD

Highlight menu item  Arrow Keys

Cycle Options Arrow Keys

Select highlighted item e 

Cancel/Return to previous screen s
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INTRODUCTION
Welcome to Bayview, your destination in Need For Speed Underground 2. In Bayview, the 
underground is thriving. With over 125 miles of open road to drive, feast on an almost 
limitless array of choices. Cruise the freeways for races, comb city streets for secret 
hotspots, or get outfitted with the latest gear at one of Bayview’s numerous shops. 
Customize your car with hundreds of accessories and aftermarket parts, including brand-
new options like spinners and audio upgrades. Once your ride is up to speed, take it to the 
streets in one of the all-new racing modes like Street X and Downhill Drift. Think you’ve got 
what it takes to make it in the underground? Here’s your chance to prove it.

SETTING UP THE GAME
Get into the underground.

MAIN MENU
CAREER Conquer Career mode and rule the underground (see p. 6).
QUICK RACE Jump right into a race (see p. 7).
ONLINE Race against friends online (see p. 7).
LAN Race others on a local area network (see p. 9).
CUSTOMIZE Outfit your ride from bumper to headlights (see p. 4).
PROFILE MANAGER Save or load your game (see p. 9).
OPTIONS Adjust audio, video, and gameplay options (see below).

OPTIONS
To access the Options menu from the Main menu, click OPTIONS.
To access the Options menu in-game, enter the Pause menu then select OPTIONS.
AUDIO Set in-game volume levels or select an audio mode.
DISPLAY Adjust video options.
GAMEPLAY Adjust the jump camera, rearview mirror, speedometer units, career 

difficulty level, and map modes, or toggle the autosave feature.
PLAYER Choose a transmission type, select stability control, change the 

default camera, or toggle heads-up display content ON/OFF.
CONTROLS Change the game controls.
EA GAMES™ TRAX Adjust Music Playback options.
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PLAYING THE GAME
GAME SCREEN

CUSTOMIZE YOUR RIDE
Competing in the underground requires an eye-catching combination of speed and beauty. 
Choose from hundreds of performance parts and visual customization modifications available 
in Need For Speed Underground 2 to make your ride look good over and under the hood.

SELECT A CAR
Your ride makes or breaks your reputation in the underground. Looks are important, but no 
one pays attention to a car that’s running dead last. 

MAKE AND MODEL
Browse the available cars, but don’t think of them as finished products. With a few wins 
under your belt you’ll be customizing these basic vehicles into exquisite street machines that 
car dealers will barely recognize.  
➟ When picking a car, check out the Acceleration, Top Speed, and Handling ratings at the 

bottom of the screen. Performance modifications can improve these characteristics later, 
but you’ll need to win some races with your stock vehicle in order to fund any serious 
work under the hood.

CUSTOMIZING
New cars are nice in the showroom, but there’s plenty of room for improvement once they hit 
the streets. Make your car your own through a thorough customization process. A vast array 
of modifications are available for your ride—if you’ve got the bank, that is.
➟ To begin customizing your vehicle, click CUSTOMIZE in the Main menu.
➟ To switch cars, click the arrows.
➟ To toggle between stock cars and the cars you own, click the arrows on the filter bar on 

the top right side of the screen.

Turbo
Nitrous
Tach
Speed

SMS

Mini Map
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VISUAL STAR RATING
You can contribute to your visual star rating by making your car look smooth and upgrading 
your performance. As you modify your car, your star value increases. The star value 
contributes to your progression through the game by rewarding you with DVD covers and 
money.
➟ The maximum number of stars you can earn is ten.

VISUAL MODS
Style is in the details, so Need for Speed Underground 2 leaves the details up to you. Choose 
from dozens of styles of hoods, rims, body kits, exhaust tips, spoilers, side mirrors, and 
more. Transform your car’s surfaces with pearlescent, gloss, or metallic paint, vinyl graphics, 
positional decals, window tints, and neon. There’s also a car specialty shop that allows you to 
install hydraulics, add some scissor doors or spinners, and put in some trunk audio.

VINYLS 
Vinyls are distinctive graphics that stick to your car’s bodywork. They can be placed in up to 
four layers, allowing you to stack graphics for a collage effect. Each vinyl’s color can also be 
customized, to further individualize your car’s look. 
➟ To stack vinyls, place the first vinyl on the bottom layer and then select a different layer 

for the next vinyl. The new vinyl is placed on top while leaving the first one undisturbed. 
You also have the ability to reorder the layers to get the perfect look.

PERFORMANCE MODS
Let’s face it, the automotive engineers who designed these cars never thought they could 
go this fast. Today’s tuner culture hungers for speed, so they’ve enhanced every aspect of 
automotive performance with hundreds of aftermarket parts. Need for Speed Underground 
2 offers hundreds of modifications, including weight reduction, nitrous oxide, suspension 
kits, ECUs, and advanced fuel systems. Add all of this available power to your car and just 
keeping it under control could be a challenge.

HYDRAULICS
If you have hydraulics installed on your car they are automatically enabled. Once you exceed 
30 mph they are automatically disabled.
➟ To pressurize, hold H and use the steering/throttle controls to indicate the section of the 

car that should use hydraulics.
➟ To bounce with level 3 hydraulics, hold J and use the steering/throttle controls to 

indicate the direction you wish to bounce.
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GAME MODES
Take on the underground in a variety of Quick Race mode races or Career mode.

CAREER MODE
Rise to the top of the underground in Career mode.
➟ To start a game in Career mode, click CAREER in the Main menu then either create a new 

profile or load an existing profile.

EXPLORING
Want to make a name for yourself in the underground? You’re going to have to find it first. In 
Career mode, the city is yours to discover. Explore it by driving around to get a feel for the lay 
of the land. As you cruise you’ll encounter rival racers who you can challenge to an Outrun 
race. Keep your eyes and ears open for hints pointing you to the areas where you can find 
the hottest races or the coolest upgrades. 
➟ If you perform a cool move while you cruise, such as impressive slides, you earn points. 

These fill up your Race Breaker meter if you have nitrous installed. Do something uncool, 
like hit another driver, and points are deducted from your Race Breaker meter.

SHOWCASE MODE
As you win races and upgrade your car, you will receive messages telling you to proceed to 
locations where a photographer is waiting to take a picture of your suped-up ride. To set up 
the best shot you can pop your hood, trunk, or doors to better show off the goods.
➟ To open or close the doors, press j/l or A/D.
➟ To open or close the hood, press i or W.
➟ To open or close the trunk, press k or S.
➟ To exit this mode, press s or click BACK.

SMS
Messages from other SMS users offer you details on races, car shops, challengers, and 
opportunities.
➟ When you see the SMS icon appear on-screen, press t. The game pauses and your 

messages appear.
➟ To return to the game from the Inbox, press s or click BACK.
➟ To return to the game from within a message, press e or click CONTINUE.

WORLD MAP
The world map offers a bird’s-eye view of the entire city. Icons representing your car, 
opponents, and the locations of potential races and shops also appear here.
➟ To access the world map, press M.
➟ To activate the GPS, click on the shop or event on the map legend or directly on the map.
➟ To hide/show shops or events on the map, click on them in the map legend.
➟ To return to the game, press s or click BACK.
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QUICK RACE MODE
Jump into the driver’s seat and let the race begin. 

To start a quick race: 
1. Click QUICK RACE in the Main menu.
2. Choose between CIRCUIT, SPRINT, DRAG, DRIFT, STREET X, UNDERGROUND RACING 

LEAGUE, or FREE RUN modes. 
3. Select a location for your race.
4. Adjust race options.
5. Select a vehicle.
6. Choose a MANUAL or AUTOMATIC transmission. The race begins.
CIRCUIT A traditional lap-style course. Finish first and leave your competitors 

driving in circles.
SPRINT Find out how fast you can get from point A to point B.
DRAG A pedal-mashing, speed-shifting race to the finish line.
DRIFT Break loose into a stylish drift and rack up the points.
STREET X Lap-based racing on tight and technical closed circuits. Fight for first 

place whatever the cost. 
UNDERGROUND  Lap-based racing on dedicated racetracks.
  RACING LEAGUE
FREE RUN No competition. No time limit. No rules. The open road beckons.

ONLINE
Take the challenge online and race the best drivers the worldwide underground has to offer.

NOTE: REGISTRATION REQUIRED TO ACCESS ONLINE FEATURES. INTERNET CONNECTION 
REQUIRED. TERMS & CONDITIONS AND FEATURE UPDATES ARE FOUND AT www.eagames.
com. YOU MUST BE 13+ TO REGISTER ONLINE.

EA MAY RETIRE ONLINE FEATURES AFTER 30 DAYS NOTICE POSTED ON www.eagames.com.

➟ To begin, select ONLINE from the Main menu.

EA ACCOUNT SETUP
Create a new account or use an existing one.
➟ To create a new EA account, click CREATE NEW EA ACCOUNT and follow the on-screen 

instructions.
➟ To use an existing account, click the default EA Account listed or select a different 

account by choosing USE EXISTING EA ACCOUNT.
➟ Your EA Account will become the default once you’ve saved it.
➟ A single player profile must be created in order to save your EA Account.

NOTE: Your CD Key is linked to the first EA Account you log in with and is 
permanently attached to that account. Please do not lose your EA Account name 
or password.
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ONLINE MENU
NEWS Get the latest news on the Need For Speed Underground 2 online 

community.
LOBBY Join an existing race, create a new online race, or set up a lobby 

filter.
SELECT CAR Choose or customize your online vehicle of choice.
RANKING View your personal stats, get the overall stats, or find out who the 

monthly point leaders are.
OPTIONS Adjust audio, video, gameplay, player, controller, and online options.
➟ To join an online game, select LOBBY in the Online menu. A list of games appears. Click 

the desired race. The game is loaded.
➟ To refresh the list of online games, click REFRESH.
➟ To filter the list of online games, click FILTER. You may filter by game mode, car 

performance, game type, race breaker, and collision detection.

To create a new online game:
1. Select LOBBY in the Online menu.
2. Click CREATE NEW GAME.
3. Chose between a CIRCUIT, SPRINT, DRAG, DRIFT, STREET X, UNDERGROUND RACING 

LEAGUE, or OUTRUN race.
4. Select the location of the race.
5. Adjust race mode options and click DONE to advance to the game lobby.

PLAYER STATUS
A list of icons appears next to a player’s name in each game room.

Awarded upon 
completion of each 

event (including non-
mandatory events) in 

Career mode 

Awarded upon 
completion of Career 

mode

Elite Ranking in  
Circuit mode

Elite Ranking in  
Sprint mode

Elite Ranking in  
Drift mode

Elite Ranking in  
Street X mode

Elite Ranking in  
the Underground  
Racing League

Elite Ranking in  
Drag mode
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EA™ MESSENGER
Find your friends online—or discover new ones.
➟ To open EA Messenger, click the EA Messenger Button 
➟ To toggle between friends lists, friends requests, and blocked players, click the arrow 

buttons.
➟ Click on a player name in the messenger to send them a message, a game invite, or 

a friend request. You may also block players from the EA Messenger as well as offer 
feedback.

LAN
Race a friend over a LAN connection.
➟ To begin, select LAN from the Main menu. The LAN menu appears.
➟ To join a LAN game, click a game name from the LAN menu. 
➟ To create a LAN game, click HOST LAN SERVER. Follow the on-screen steps. Your game 

is created and the Game Lobby appears.

SAVING AND LOADING
To save a game:
1. Click PROFILE MANAGER in the Main menu.
2. Chose SAVE. Your game is saved.

To load a game in Career mode:
1. Click CAREER in the Main menu.
2. Select LOAD GAME.
3. Select a profile. Your game is loaded.
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PERFORMANCE TIPS
SYSTEM REQUIREMENTS
It is essential that your PC meets the Minimum Requirements as detailed on the game’s packaging. 
If you are experiencing poor performance, check to make sure your system hardware supports the 
requirements.

BACKGROUND TASKS
In some cases programs that are running on your system can monopolize resources that the game needs 
in order to install, load, and run properly. Not all of these programs are immediately visible. There are a 
number of programs, called “background tasks,” that are always running on your system.

IMPORTANT NOTE: While shutting down background tasks will optimize 
your system for running Need For Speed Underground 2, these background tasks’ 
features will be unavailable once shut down. Be sure to re-enable background 
tasks after playing Need For Speed Underground 2  by restarting your computer.

If your system is running anti-virus or crash guard programs you will need to close or disable them to 
run Need For Speed Underground 2. To do this, find the icon for the program on the Windows Taskbar 
and then right-click the icon and select “close,” “disable,” or the relevant option. Please note that these 
programs will be reactivated the next time you restart your computer.
Once anti-virus and crash guard programs have been disabled, you should end all unnecessary general 
background tasks. 

To view and close background tasks (Windows XP):
1. Hold down v and a and then tap m. The Windows Task Manager appears.
2. Click the Processes tab. This tab displays a list of all background tasks running on your system.
3. Click the User Name column heading. This sorts all the processes together by user name.
4. Select an item with a user name, but DO NOT select one from the SYSTEM, LOCAL SERVICE, or 

NETWORK SERVICE groups. Also, DO NOT select the explorer.exe or taskmgr.exe items.
5. Click END PROCESS. You may receive a warning message, if so click YES. The selected item 

disappears from the list.
6. Repeat steps 4 and 5 until only explorer.exe and taskmgr.exe remain in the user name group.

To view and close background tasks (Windows Me or 98):
1. Hold down v and a and then tap m. The Close Program window appears. This 

window displays a list of all background tasks running on your system.
2. Select an item, but DO NOT select the Explorer or Systray items. 
3. Click END TASK. The Close Program window closes and the task is ended.
4. Repeat steps 1 through 3 until only Explorer and Systray remain.

VIDEO AND SOUND DRIVERS
An outdated video or sound driver can lead to slow and choppy gameplay, or in some cases can prevent 
the game from running at all. To ensure an enjoyable experience with Need For Speed Underground 2, be 
sure that you have the most recent video and sound drivers installed. These drivers are typically available 
for download from your system or hardware manufacturer’s website. If you are not sure what type of video 
or sound card you have, or you don’t know how to update the drivers on your system, please refer to the 
documentation that came with your system or peripheral. 
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INTERNET PERFORMANCE 
ISSUES
To avoid poor performance during Internet play, be sure that you close any file sharing, streaming audio, 
or chat programs prior to entering gameplay. These applications can monopolize your connection’s 
bandwidth, causing lag or other undesirable effects.
Need For Speed Underground 2 uses the following TCP and UDP port(s) for Internet play:
 TCP 80, 13505, 20920-20929, 20970-20979
 UDP 3658, 3659
Please consult your router or personal firewall documentation for information on how to allow game 
related traffic on these ports. If you are attempting to play on a corporate Internet connection, contact your 
network administrator. 

TECHNICAL SUPPORT
If you have trouble with Need for Speed Underground 2, EA Technical Support can help. The EA Help file 
provides solutions and answers to the most common difficulties and questions about how to properly use 
this product.

To access the EA Help file:
➟  Left-click the Start button from the Windows Taskbar and select All Programs (or Programs) >  

EA GAMES > NEED FOR SPEED UNDERGROUND 2 > Technical Support. 

NOTE: If Need for Speed Underground 2 is not installed, EA Help can be accessed 
directly off Need for Speed Underground 2 Disc 1. With Disc 1 in the drive,  left-
click the Start button from the Windows Taskbar and select Run…. Type D:\
Support\EA Help\Electronic_Arts_Technical_Support.htm in the Run dialog box, then 
click OK (substitute the correct letter of your CD/DVD-ROM drive if other than ‘D:’).

If you are still experiencing difficulty after utilizing the information in the EA Help file, you can also contact 
EA Technical Support. An EAsy Info utility is included that detects your system’s hardware and organizes 
this information into a detailed report. This report helps EA Technical Support solve your problem in the 
quickest possible time. Please note that you will need to have registered your copy of Need for Speed 
Underground 2 in order to take advantage of this utility.

To run the utility:
➟  Left-click the Start button from the Windows Taskbar and select All Programs (or Programs) >  

EA GAMES > NEED FOR SPEED UNDERGROUND 2 > EAsy Info

NOTE: If Need for Speed Underground 2 is not installed, EAsy Info can be 
accessed directly off Need for Speed Underground 2 Disc 1. With Disc 1 in the 
drive, left-click the Start button from the Windows Taskbar and select Run…. 
Type D: \Support\EAsyInfo in the Run dialog box, then click OK (substitute the 
correct letter of your CD/DVD-ROM drive if other than ‘D:’).

This utility gathers information about the hardware in your system. To save this information to send to 
EA Technical Support, Click File > Export to Desktop > EAsy Info Report. This will create a copy of the 
report that is saved to your Windows desktop.
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EA TECHNICAL SUPPORT ON THE INTERNET
If you have Internet access, be sure to check our EA Technical Support website at:
 techsupport.ea.com
Here you will find a wealth of information on DirectX, game controllers, modems, and networks, as 
well as information on regular system maintenance and performance. Our website contains up-to-date 
information on the most common difficulties, game-specific help, and frequently asked questions (FAQs). 
This is the same information our support technicians use to troubleshoot your performance issues. We 
keep the support website updated on a daily basis, so please check here first for no-wait solutions. 
If you are unable to find the information you need on our website, please feel free to contact EA 
Technical Support via e-mail, phone, or letter. Please be sure to include the EAsy Info utility report in 
your e-mail or letter. 
If you need to talk to someone immediately, call us at (650) 628-1005. Please have the EAsy Info utility 
report printed and ready when you call. This will help us service your call in the quickest possible time. 

EA TECHNICAL SUPPORT CONTACT INFO
E-mail and Website: http://techsupport.ea.com
FTP site: ftp.ea.com
Mailing Address:  EA Technical Support 

P.O. BOX 9025 
Redwood City, CA  94063-9025

If you live outside of North America, you can contact one of our other offices.

CUSTOMER SUPPORT - Here to help you!
Problem? Question? If you are having problems with your game, we are here to help.

SOUTH AFRICA
Game Smith: (011) 740-0615/6
Electronic Arts South Africa
PO Box 3180
Rivonia
2128

KEEP UP WITH THE LATEST EA NEWS..!
If you want to keep up with all the latest news, downloads and coolest updates from EA
then all you have to do is register as an EA Direct Member. It’s easy!
Register now on
 www.eagames.com.au
 or
 www.easports.com.au
As an EA Direct Member you will be kept in the ‘know’ as to what is new and hot from
EA Australia, delivered directly to your inbox.

AUSTRALIA
Electronic Arts Australia Support Hotline: 1902 261 600*
*Sirius calls charged at $2.48 per minute, GST inc. Calls 
from Mobile & Public phones higher (If you are under 18 
years of age parental consent is required).
Operating hours from 9am to 8pm 7 days a week, as 
well as pre-recorded information 24 hours a day.

Customer Service Address:
Electronic Arts
PO Box 432
Southport QLD
4215, Australia

NEW ZEALAND
Electronic Arts New Zealand, Games Hotline: 
0900 58885*
(If you are under 18 years of age parental 
consent required).
*Calls charged at $1.99 per minute inc GST 7 
days a week 9am - 8pm.
Calls from Mobile & Public phones are higher.

Customer Service Address:
Electronic Arts New Zealand
PO Box 47596
Ponsonby
New Zealand



Warranty 
Warranty Electronic Arts Limited
Electronic Arts warrants to the original purchaser of this product that the recording medium on which the 
software program(s) are recorded (the “Recording Medium”) and the documentation that is included 
with this product (the “Manual”) are free from defects in materials and workmanship for a period of 90 
days from the date of purchase. If the Recording Medium or the Manual is found to be defective within 90 
days from the date of purchase, Electronic Arts agrees to replace the Recording Medium or Manual free 
of charge upon receipt of the Recording Medium or Manual at its service center, postage paid, with proof 
of purchase. This warranty is limited to the Recording Medium containing the software program and the 
Manual that were originally provided by Electronic Arts. This warranty shall not be applicable and shall be 
void if, in the judgment of Electronic Arts, the defect has arisen through abuse, mistreatment or neglect. 
This limited warranty is in lieu of all other warranties, whether oral or written, express or implied, 
including any warranty of merchantability or fitness for a particular purpose, and no other representation 
of any nature shall be binding on or obligate Electronic Arts. If any such warranties are incapable of 
exclusion, then such warranties applicable to this product, including implied warranties of merchantability 
and fitness for a particular purpose, are limited to the 90-day period described above. In no event will 
Electronic Arts be liable for any special, incidental, or consequential damages resulting from possession, 
use or malfunction of this Electronic Arts product, including damage to property, and to the extent 
permitted by law, damages for personal injury, even if Electronic Arts has been advised of the possibility 
of such damages. Some states do not allow limitation as to how long an implied warranty lasts and/or 
exclusions or limitation of incidental or consequential damages so the above limitations and/or exclusion 
of liability may not apply to you. In such jurisdictions, the Electronic Arts’ liability shall be limited to the 
fullest extent permitted by law. This warranty gives you specific rights. You may also have other rights 
that vary from state to state.

RETURNS WITHIN THE 90-DAY WARRANTY PERIOD
Please return the product along with (1) a copy of the original sales receipt, showing the date of 
purchase, (2) a brief description of the difficulty you are experiencing and (3) your name, address and 
phone number to the address below and Electronic Arts will mail a replacement Recording Medium 
and/or Manual to you. If the product was damaged through misuse or accident, this 90-day warranty is 
rendered void and you will need to follow the instructions for returns after the 90-day warranty period. 
We strongly recommend that you send your product using a traceable delivery method. Electronic Arts is 
not responsible for products not in its possession.

RETURNS AFTER THE 90-DAY WARRANTY PERIOD
If the defect in the Recording Medium or Manual resulted from abuse, mistreatment or neglect, or if the 
Recording Medium or Manual is found to be defective after 90 days from the date of purchase, please 
return the product along with (1) a check or money order for $7.50 made payable to Electronic Arts, (2) a 
brief description of the difficulty you are experiencing and (3) your name, address and phone number to 
the address below, and Electronic Arts will mail a replacement Recording Medium and/or Manual to you. 
We strongly recommend that you send your product using a traceable delivery method. Electronic Arts is 
not responsible for products not in its possession.
EA Warranty Contact Info
E-mail and Website: http://techsupport.ea.com
Phone:  (650) 628-1900
EA Warranty Mailing Address
Electronic Arts Customer Warranty
P.O. Box 9025
Redwood City, CA  94063-9025

NOTICE
Electronic Arts reserves the right to make improvements in the product described in this manual at 
anytime and without notice. This manual and the product described in this manual are copyrighted. 
All rights reserved. No part of this manual may be copied, reproduced, translated, or reduced to any 
electronic medium or machine readable form without prior written consent of Electronic Arts, P.O. Box 
9025, Redwood City, California 94063-9025.
© 2004 Electronic Arts Inc. Electronic Arts, EA, EA GAMES, EA GAMES logo and Need for Speed are 
trademarks or registered trademarks of Electronic Arts Inc. in the U.S. and/or other countries. All rights 
reserved. THX is a trademark or registered trademark of THX Ltd. All rights reserved. All other trademarks 
are the property of their respective owners. EA GAMES™ is an Electronic Arts™ brand.
 THX is a trademark or registered trademark of THX Ltd. All rights reserved.
 A THX Certified Game is your assurance of consistent and optimal sound and picture  
 performance. This game title was  developed in a studio that meets THX’s stringent  
 reference standards for acoustical and visual performance, letting you enjoy the  
 best in sound and picture playback.




